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Regulatory Compliance

The ADSP-CM403F EZ-KIT Lite is designed to be used solely in a labo-
ratory environment. The board is not intended for use as a consumer end
product or as a portion of a consumer end product. The board is an open
system design which does not include a shielded enclosure and therefore
may cause interference to other electrical devices in close proximity. This
board should not be used in or near any medical equipment or RF devices.

The ADSP-CM403F EZ-KIT Lite is in the process of being certified to
comply with the essential requirements of the European EMC directive

2004/108/EC and therefore carries the “CE” mark.

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge)

sensitive devices. Electrostatic charges readily accumulate on the human

body and equipment and can discharge without detection. Permanent dam- A
age may occur on devices subjected to high-energy discharges. Proper ESD

precautions are recommended to avoid performance degradation or loss of ‘ % \
functionality. Store unused EZ-KIT Lite boards in the protective shipping

package.
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PREFACE

Thank you for purchasing the ADSP-CM403F EZ-KIT Lite®, Analog
Devices, Inc. low-cost evaluation system for the ADSP-CM403F
mixed-signal control processor.

The ADSP-CM403F processor is based on the ARM® Cortex®-M4 pro-
cessor core and is designed for photovoltaic applications. The EZ-KIT
Lite is shipped with all of the necessary hardware—you can start the eval-
uation immediately. The package contains the standalone evaluation
board and CE-approved power supply. The EZ-KIT Lite version ships
with the J-Link Lite ARM, while the EZ-Board® version requires the cus-
tomer to provide a debugger.

Two expansion connectors (analog interface and PWM/digital interface)
are provided for connecting boards that incorporate motors. Another
expansion connector is provided for connecting an Anybus board and/or a
memory/FPGA extender card.

Traditional mechanical switches for changing the board’s factory setup
have been removed in favor of I*?C controlled software switches. The only
remaining mechanical switches are the boot mode switch and push
buttons.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual ix



Product Overview

The evaluation board is designed to be used in conjunction with the IAR
Embedded Workbench development tools to test capabilities of the
ADSP-CM403F processors. The development environment aids advanced
application code development and debug, such as:

* Create, compile, assemble, and link application programs written
in C++, C, and assembly

* Load, run, step, halt, and set breakpoints in application programs
* Read and write data and program memory

* Read and write core and peripheral registers

Product Overview

The board features:
e Analog Devices ADSP-CM403F processor

* 120-pin LQFP package
* 30 MHz CLKIN core oscillator
* Universal Asynchronous Receiver/Transmitter (UARTO)
* Analog Devices ADM3252E RS-232 line transceiver

¢ DB9 female connector

e Controller Area Network (CAN) interface
* Analog Devices ADM3053 transceiver

* RJ11 connector

X ADSP-CM403F EZ-KIT Lite Evaluation System Manual



Preface

* Display
* New Haven NHD-0220D3Z-FL-GBW
* 2 x 20 character
e 2-wire interface (T'WI) control

* RESET controller

* Analog Devices ADM708 microprocessor supervisory
circuits

* Debug (JTAG/SWD/SWV/TRACE) interface
* JTAG/SWD 20-pin 0.1” header for use with IAR emulators
* Trace/JTAG/SWD/SWYV 20-pin 0.05” header

e LEDs

* Six LEDs: one power (green), one board reset (red), one
SYS_FAULT (red), and three general-purpose (amber)

e Push buttons
* Three push buttons: one reset, two IRQ/Flag
* Asynchronous connector

* 180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing
e SMCO address, data, and control

» CLKOUT
» SPIO

e UART2

« TWIO

* GPIOs

ADSP-CM403F EZ-KIT Lite Evaluation System Manual x1



Product Overview

RESET
GND/3.3V/5V output

* Pulse-width modulation (PWM) connector

180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing
PWMO-PWM?2
SINCO

SPI0

TWIO

T™MO

CNTO-CNT1
SPORT1

GPIO

RESET
GND/3.3V/5V output

5V input

* Analog connector interface

120-pin Samtec (QSH-060-01-F-D-A) 0.5 mm spacing
ADCO0-ADCI1

DACO0-1

AGND/GND/VREF/5V output

ADR441 voltage reference (VREF)

ADA4899 buffer—0.1” header for reference

Xil
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* External power supply

* CE compliant

* 5V@3.6 Amps

* Ability to power from the PWM connector
* Other features

* 0.05-ohm resistors for processor current measurement

For information about the hardware components of the EZ-KIT Lite,
refer to ADSP-CM403F EZ-KIT Lite Bill Of Materials.

Purpose of This Manual

The ADSP-CM403F EZ-KIT Lite Evaluation System Manual provides
instructions for installing the product hardware (board). The text
describes operation and configuration of the board components and pro-
vides guidelines for running your own code on the ADSP-CM403F
EZ-KIT Lite. Finally, a schematic and a bill of materials are provided for
reference.
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Intended Audience

Intended Audience

The primary audience for this manual is a programmer who is familiar
with an ARM Cortex-M4-based core.

The ADSP-CM40x family of mixed-signal control processors is based on
the ARM Cortex-M4 processor core with floating-point unit and inte-
grated SRAM memory, flash memory, accelerators, and peripherals.

The applicable documentation for programming the ARM Cortex-M4

processor core includes:
*  Cortex-M4 Devices Generic User Guide
o CoreSight ETM-M4 Technical Reference Manual
»  Cortex-M4 Technical Reference Manual

For additional information on this Analog Devices processor, see the
ADSP-CM40x Mixed-Signal Control Processor Hardware Reference. This
document describes the ARM Cortex-M4 processor core and memory
architecture used on the ADSP-CM40x processor, but does not provide
detailed programming information for the ARM core.

For more information about programming the ARM core, visit the ARM
Information Center:

http://infocenter.arm.com/help/
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Manual Contents

The manual consists of:

Chapter 1, Using ADSP-CM403F EZ-KIT Lite
Describes EZ-KIT Lite functionality from a programmer’s perspec-
tive and provides a simplified memory map of the processor.

Chapter 2, ADSP-CM403F EZ-KIT Lite Hardware Reference
Provides information about the EZ-KIT Lite hardware
components.

Appendix A, ADSP-CM403F EZ-KIT Lite Bill Of Materials
Lists the hardware components used to manufacture the EZ-KIT
Lite.

Appendix B, ADSP-CM403F EZ-KIT Lite Schematic
Lists the resources for board-level debugging.

What’s New in This Manual

This is the first edition (Revision 1.0) of the ADSP-CM403F EZ-KIT Lite
Evaluation System Manual.
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Technical Support

Technical Support

You can reach Analog Devices processors and DSP technical support in
the following ways:

Post your questions in the processors and DSP support community
at EngineerZone™:
http://ez.analog.com/community/dsp

Submit your questions to technical support directly at:
http://www.analog.com/support

E-mail your questions about processors and processor applications
to:

processor.support@analog.com or

processor.china@analog.com (Greater China support)

In the USA only, call 1-800-ANALOGD (1-800-262-5643)

Contact your Analog Devices sales office or authorized distributor.
Locate one at:
www.analog.com/adi-sales

Send questions by mail to:

Processors and DSP Technical Support
Analog Devices, Inc.

Three Technology Way

P.O. Box 9106

Norwood, MA 02062-9106

USA

Supported Processors

This evaluation system supports Analog Devices ADSP-CM403F

processors.

xvi
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Supported Tools

Information on supported tools for the ADSP-CM403F EZ-KIT Lite and
the ADSP-CM40x family of mixed-signal control processors is available
at:

http://www.analog.com/CM403FEZKit

Product Information

Product information can be obtained from the Analog Devices Web site
and the online help system.

Analog Devices Web Site

The Analog Devices Web site, www.analog.com, provides information
about a broad range of products—analog integrated circuits, amplifiers,
converters, and digital signal processors.

To access a complete technical library for each processor family, go to
http://www.analog.com/processors/technical_library. The manuals
selection opens a list of current manuals related to the product as well as a
link to the previous revisions of the manuals. When locating your manual
title, note a possible errata check mark next to the title that leads to the
current correction report against the manual.

Also note, myAnalog.com is a free feature of the Analog Devices Web site
that allows customization of a Web page to display only the latest
information about products you are interested in. You can choose to
receive weekly e-mail notifications containing updates to the Web pages
that meet your interests, including documentation errata against all manu-
als. myAnalog.com provides access to books, application notes, data sheets,
code examples, and more.
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Notation Conventions

Visit myAnalog.com (found on the Analog Devices home page) to sign up.
If you are a registered user, just log on. Your user name is your e-mail

address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices. It allows
you direct access to ADI technical support engineers. You can search
FAQs and technical information to get quick answers to your embedded
processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar
design challenges. You can also use this open forum to share knowledge
and collaborate with the ADI support team and your peers. Visit
http://ez.analog.com to sign up.

Notation Conventions

Text conventions used in this manual are identified and described as

follows.

Example

Description

File > Close

Titles in reference sections indicate the location of an item within the
CCES environment’s menu system (for example, the Close command
appears on the File menu).

{this | that)

Alternative required items in syntax descriptions appear within curly
brackets and separated by vertical bars; read the example as this or
that. One or the other is required.

[this | that]

Optional items in syntax descriptions appear within brackets and sepa-
rated by vertical bars; read the example as an optional this or that.

[this,..]

Optional item lists in syntax descriptions appear within brackets delim-
ited by commas and terminated with an ellipse; read the example as an
optional comma-separated list of this.

xviil
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Example Description

SECTION Commands, directives, keywords, and feature names are in text with
letter gothic font.

filename Non-keyword placeholders appear in text with italic style format.

Note: For correct operation, ...
A Note provides supplementary information on a related topic. In the
online version of this book, the word Note appears instead of this

symbol.

Caution: Incorrect device operation may result if ...
Caution: Device damage may result if ...
/ A Caution identifies conditions or inappropriate usage of the product
that could lead to undesirable results or product damage. In the online
version of this book, the word Caution appears instead of this symbol.

‘Warning: Injury to device users may result if ...

® A Warning identifies conditions or inappropriate usage of the product

that could lead to conditions that are potentially hazardous for the
devices users. In the online version of this book, the word Warning

appears instead of this symbol.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual XX
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1 USING ADSP-CMA403F EZ-KIT
LITE

This chapter provides information to assist you with development of pro-

grams for the ADSP-CM403F EZ-KIT Lite evaluation system.

The following topics are covered.

Package Contents

ADSP-CM403F EZ-Board

Default Configuration

IAR Embedded WorkBench and Board Installation
IAR Embedded WorkBench Session Startup
SPI Flash

Analog Interface

UARTO Interface (RS-232)

CANO Interface

Debug Interface

Serial Liquid Crystal Display Module Interface
Power-On-Self Test

Expansion Interface

Power Architecture
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Package Contents

e DPower Measurements
* Example Programs
* Reference Design Information

For detailed information on how to program the ADSP-CM403F proces-
sor, refer to the documents listed in the Preface.

Package Contents

Your ADSP-CM403F EZ-KIT Lite package contains the following items:
* ADSP-CM403F EZ-KIT Lite board
e Universal 5V DC power
* J-Link Lite ARM (only in the EZ-KIT Lite version)

Contact the vendor where you purchased your EZ-KIT Lite or contact
Analog Devices, Inc. if any item is missing.
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Using ADSP-CM403F EZ-KIT Lite

ADSP-CM403F EZ-Board

The ADSP-CM403F EZ-KIT Lite is shipped with the J-Link Lite ARM
debugger. When the product is not shipped with the debugger, it is
referred to as the ADSP-CM403F EZ-Board.

@ The EZ-Board requires a third party emulator.

Default Configuration

The ADSP-CM403F EZ-KIT Lite board is designed to run outside your

personal computer as a standalone unit.

When removing the EZ-KIT Lite board from the package, handle the
board carefully to avoid the discharge of static electricity, which can dam-
age some components.

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge)
sensitive devices. Electrostatic charges readily accumulate on the human body

and equipment and can discharge without detection. Permanent damage may A
occur on devices subjected to high-energy discharges. Proper ESD precau- \
tions are recommended to avoid performance degradation or loss of function-

ality. Store unused EZ-KIT Lite boards in the protective shipping package.
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Default Configuration

Figure 1-1 shows the default jumper and boot mode switch settings used
in installation. Confirm that your board is in the default configuration
before using the board.

O swi
JP4
- P
. s
- P4

JP3

[ O JP2
L0 JP1

Figure 1-1. Default EZ-KIT Lite Hardware Setup
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Using ADSP-CM403F EZ-KIT Lite

IAR Embedded WorkBench and Board

Installation
For information about the IAR Embedded WorkBench® product and
software download, go to:

http://www.iar.com/en/Products/IAR-Embedded-Workbench

The ADSP-CM403F EZ-KIT Lite software, based on the IAR Embedded
WorkBench, can be found at:

http://www.analog.com/CM403FEZKit

Follow these instructions to ensure correct operation of the product soft-
ware and hardware.

Step 1: Connect the EZ-KIT Lite board to a personal computer (PC) run-
ning IAR Embedded WorkBench using a J-Link/]J-Trace emulator.

1. Plug one side of the USB cable into the USB connector of the emu-
lator. Plug the other side into a USB port of the PC running IAR
Embedded WorkBench.

2. Attach the emulator to the header connector, P1 or P2, on the

EZ-KIT Lite board.

Step 2: Attach the provided cord and appropriate plug to the 5V power
adaptor.

1. Plug the jack-end of the power adaptor into the power connector

P7 (labeled 5V) on the EZ-KIT Lite board.

2. Plug the other side of the power adaptor into a power outlet. The
power LED (labeled LEDS) is lit green when power is applied to the
board.
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IAR Embedded WorkBench Session Startup

IAR Embedded WorkBench Session
Startup

It is assumed that the JAR Embedded WorkBench software is installed

and running on your PC.

1.

Navigate to the IAR Embedded WorkBench environment via the
Start menu.

Note that JAR Embedded WorkBench is not connected to the tar-
get board.

Choose File > Open >Workspace to open a workspace for the proj-
ect to download and debug.

Choose Project > Options.

The General Options, Target page appears.

In Processor variant, ensure Device is AnalogDevices
ADSP-CM40z-X_Y, where X is the SRAM size in KB and Y is the
internal flash size in KB of the part on the target board.

On the Analog Devices ADSP-CM403F EZ-KIT Lite, SRAM size
is 384 KB, and internal flash size is 2048 KB.

1-6
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Using ADSP-CM403F EZ-KIT Lite

5. Choose Debugger in the Category pane.

The Debugger, Setup options page appears.

a.

In Driver, choose J-Link/J-Trace as the emulator to be used

to debug the target board.

Click the Download tab. The Debugger, Download options
page appears.

Ensure Use flash loader(s) is enabled. Note that other
download settings are optional.

6. Choose Debugger > J-Link/J-Trace in the Category pane.

The emulator Setup options page appears.

a.

On the Setup page,

In Reset, select Connect during reset from the drop-down
list.

In JTAG/SWD speed, select Auto.

(Optional) In Clock setup, change the default values.
On the Connection page,

In Communication, select USB and Device 0.

In Interface, select JTAG or SWD.

7. Click OK to save the emulator settings.

8. Choose Project > Debug and Download to download the project
and start debugging.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual 1-7



SPI Flash

SPI Flash

The EZ-KIT Lite ships with an internal 4 MB SPI flash, connected via the
SPI2 interface, which is used for booting and scratchpad space. Refer to
the ADSP-CM40x Mixed-Signal Control Processor Hardware Reference for
more information about the internal SPI flash.

For more information, refer to the SPI flash example in the POST, which
is included in the ADSP-CM40x Enablement Software.

Analog Interface

The ADSP-CM403F processor provides two 16-bit ADCs with 12 inputs
each, ADCO and ADC1. The ADC signals are connected to the Analog expan-

sion connector (J9). There are also two 12-bit DACs available on J9.
Refer to ADSP-CM403F EZ-KIT Lite Schematic for more information.

Voltage reference for the ADC channels can be supplied internally from
the processor or externally by ADR441 ICs. U6 is the VREFO supply exter-
nal source, and U2 is its VREF1 equivalent. To select the external source for
either supply, place a jumper on JP1 or JP2. Refer to ADSP-CM403F
EZ-KIT Lite Schematic for more information.

A buffered version of the voltage reference is available on J9 via a unity
gain buffer ADA4889 (U22). By default, the internal VREFO source is
selected as the input to the buffer (JP3 positions 1 and 2). If the external
voltage reference is desired, change the jumper to JP3 positions 2 and 3.

Voltage references for the analog inputs are configurable; refer to Jumpers
for more information.
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Using ADSP-CM403F EZ-KIT Lite

UARTO Interface (RS-232)

The ADSP-CM403F processor has three built-in universal asynchronous
transmitters (UART's). UARTO is connected to a RS-232 line transmitter.
UARTO has full RS-232 functionality via the Analog Devices ADM3252E
isolated line driver and receiver (U23).

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

Pin PC_02/UARTO_TX/TRACE_DO3/SPI0_RDY of the processor is connected to
the ADM3315 device directly and used for UART transmit.

Pin PC_01/UARTO_RX/SMCO_A05/TMO_ACI5 is connected through SoftConfig
by default and used for UART receive. (This can be changed through
SoftConfig.)

By default, the UARTO CTS signal is not connected, and the UARTO RTS sig-
nal is connected to RS-232. Both connections can be changed through

SoftConfig.

The SoftConfig switches also allow the loopback of CTS and RTS. The
UARTO CTS can be added as an input to the reset circuit through SoftCon-
fig. Refer to Software-Controlled Switches (SoftConfig) for more

information.

For more information, refer to the UART example in the POST, which is
included in the ADSP-CM40x Enablement Software. Note that the loop-
back of TX and RX data is done through an external connector.
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CANO Interface

CANDO Interface

The Controller Area Network 0 (CANO) interface of the EZ-KIT Lite is
connected to the Analog Devices ADM3053 isolated CAN transceiver
(U26). The transceiver is attached to the CANO port of the ADSP-CM403F
processor via an RJ-11 connector (J8). See CANO Connector (J8).

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

The CANO transmit and receive signals are connected through the Soft-
Conlfig switches and enabled by default. See Software-Controlled Switches
(SoftConfig).

For more information, refer to the CANO example in the POST, which is
included in the ADSP-CM40x Enablement Software.

Debug Interface

The EZ-KIT Lite provides a JTAG/SWD/SWYV connection via a connec-
tor (P1), which is a 0.1” header. A 4-bit trace connection also includes
JTAG/SWD/SWYV and is available via a connector (P2). See
JTAG/SWD/SWV Connector (P1) and TRACE and JTAG/SWD/SWV

Connector (P2) for more information.

Serial Liquid Crystal Display Module
Interface

Connector J3 mates with the Newhaven Display International
NHD-0220D3Z-FL-GBW-V3, a 2-line by 20-character display with a
yellow/green backlight.
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The display is written using the TWI interface. The TWI address of the
display is 0x50. The maximum clock rate for the display is 100 kHz. The
display can be removed if the frequency limitation poses a problem.

For more information, refer to the serial liquid crystal display example in

the POST, which is included in the ADSP-CM40x Enablement Software.

Power-On-Self Test

The Power-On-Self-Test Program (POST) tests all EZ-KIT Lite peripher-
als and validates functionality as well as connectivity to the processor.
Once assembled, each EZ-KIT Lite is fully tested for an extended period
of time with POST. All EZ-KIT Lite boards are shipped with POST pre-
loaded into flash memory. The POST is executed by resetting the board
and pressing the proper push button(s). The POST also can be used as a

reference for a custom software design or hardware troubleshooting.

Note that the source code for the POST program is included in the
ADSP-CM40x Enablement Software along with the readme. txt file that
describes how the board is configured to run POST.

Expansion Interface

The expansion interface allows a custom-design daughter board to be
tested across various hardware platforms that have the same expansion
interface.

The expansion interface implemented on the ADSP-CM403F EZ-KIT
Lite consists of three connectors: Asynch or Memory Connector (J2),
PWM Connector (J7), and Analog Connector (J9). The connectors con-
tain a majority of the processor’s signals. For pinout information, go to

ADSP-CM403F EZ-KIT Lite Schematic.
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Limits to current and interface speed must be taken into consideration
when using the expansion interface. Current for extenders connected to J2
or J6 can be sourced from the EZ-KIT Lite; therefore, the current should
be limited to 250 mA for 5V, and 200 mA from the 3.3V planes. If more
current is required, a separate power connector and a regulator must be
designed on the daughter card. Additional circuitry implemented on
extender cards can add extra loading to signals, decreasing their maximum
effective speed.

Analog Devices does not support and is not responsible for the
effects of additional circuitry.

Power Architecture

The ADSP-CM403F EZ-KIT Lite has two primary voltage domains: 3.3V
and 1.2V. The main input is a 5V wall adaptor. The 5V source can be
selected via JP4 to input from the PWM connector (J7) as an alternative

to the wall power adaptor. Refer to PWM Connector (J7) and Power
Select Jumper (JP4) for details.

The Analog Devices ADP2119 controller provides 3.3V for the VDD_EXT
signal and the 3.3V power requirements of the board. The VDD_INT signal
is delivered through either Analog Devices regulator ADP2119 (VR1) or a
PNP transistor (Q1).

Power Measurements

Locations are provided for measuring the current draw from various power
planes. Precision 0.05 ohm shunt resistors are available on the

VDD_EXT, VDD_INT, and 3.3V voltage domains. For current draw, the
jumper is removed, voltage across the resistor can be measured using an
oscilloscope, and the value of the resistor can be measured using a preci-
sion multi-meter. Once voltage and resistance are measured, the current
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can be calculated by dividing the voltage by the resistance. For the highest
accuracy, a differential probe should be used for measuring the voltage
across the resistor. For more information, refer to Power Jumpers (P4-0).

Example Programs

Example programs are provided with the ADSP-CM40x Enablement Soft-
ware to demonstrate various capabilities of the product. The programs can
be found in the CM403F_CM408F_EZ-KIT\examples folder. Refer to a
readme file provided with each example for more information.

Reference Design Information

A reference design info package is available for download on the Analog
Devices Web site. The package provides information on the design, lay-
out, fabrication, and assembly of the EZ-KIT Lite.

The information can be found at:

http://www.analog.com/CM403FEZKit
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2 ADSP-CM403F EZ-KIT LITE
HARDWARE REFERENCE

This chapter describes the hardware design of the ADSP-CM403F
EZ-KIT Lite board.

The following topics are covered.

System Architecture
Describes the board’s configuration and explains how the board
components interface with the processor.

Software-Controlled Switches (SoftConfig)
Lists and describes the processor signals routed through the soft-
ware-controlled switches.

Push Buttons and Switches
Shows the locations and describes the push buttons and switches.

Jumpers
Shows the locations and describes the configuration jumpers.

LEDs
Shows the locations and describes the LEDs.

Connectors

Shows the locations and provides part numbers for the on-board
connectors. In addition, the manufacturer and part number infor-
mation is provided for the mating parts.
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System Architecture

System Architecture

This section describes the processor’s configuration on the EZ-KIT Lite
(Figure 2-1).

30 MHz ! ;
Oscillator RS-232 ADI .
3.3 Volts ADM3252E EDMaosa ‘ LEDs (3) ‘ PBs (2)

A L

4 \ A

‘ UARTO‘ ‘ CANO ‘ ’G’F’« UART2 SMCO
-« ADSP-CM403F

AFE ’@ SPI0
- 2 16-bit ADCs

_ 2 12-bit A r
12inputs each|  DACs ‘PWMO:Z‘ ‘ SINCO ‘ ‘CNTO:1‘ ‘ TWI0
A * |
YyYvy

Figure 2-1. EZ-KIT Lite Block Diagram

This EZ-KIT Lite is designed to demonstrate the ADSP-CM403F proces-
sor’s capabilities. The ADSP-CM403F EZ-KIT Lite has a 30 MHz input
clock and runs at 240 MHZ internally.
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User I/O to the processor is provided in the form of two user push buttons
and three LEDs. The software-controlled switches (SoftConfig) facilitate
the switch multi-functionality by disconnecting the push buttons from
their associated processor pins and reusing the pins elsewhere on the
board. See ADSP-CM403F EZ-KIT Lite Schematic for more information.

Software-Controlled Switches
(SoftConfig)

On the ADSP-CM403F EZ-KIT Lite, most of the traditional mechanical
switches have been replaced by I°C software-controlled switches. The
remaining mechanical switches are provided for changing the boot mode
and push buttons. Reference any SoftConfig*.c file found in the installa-
tion directory for an example of how to set up the SoftConfig feature of

the ADSP-CM403F EZ-KIT Lite through software.

The SoftConfig section of this manual serves as a reference to any user
that intends to modify an existing software example. If software provided
from ADI is used, there should be little need to reference this section.

Care should be taken when changing SoftConfig settings not to
create a conflict with interfaces. This is especially true when con-
necting extender cards.

Overview of SoftConfig

In order to further clarify the use of electronic single FET switches and
multi-channel bus switches, an example of each is illustrated and com-
pared to a traditional mechanical switching solution. This is a generic

example that uses the same FET and bus switch components that are on
the EZ-KIT Lite.

After this generic discussion there is a detailed explanation of the Soft-

Config interface specific to the ADSP-CM403F EZ-KIT Lite.
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Figure 2-2 shows two individual FET switches (Pericom PI3A125CEX)
with reference designators UA and UB. Net names ENABLE_A and ENABLE_
B control UA and UB. The default FET switch enable settings in this
example are controlled by resistors RA and RB which pull the enable pin 1
of UA and UB to ground (low). In a real example, these enable signals are
controlled by the Microchip 1O expander. The default pull-down resistors
connects the signals EXAMPLE_SIGNAL_A and EXAMPLE_SIGNAL_B and also
connects signals EXAMPLE_SIGNAL_C and EXAMPLE_SIGNAL_D. To disconnect
EXAMPLE_SIGNAL_A from EXAMPLE_SIGNAL_B, the Microchip IO expander is
used to change ENABLE_A to a logic 1 through software that interfaces with
the Microchip. The same procedure for ENABLE_B disconnects EXAMPLE_
SIGNAL_C from EXAMPLE_SIGNAL_D.

UA
ENABLE_A = I5g
EXAMPLE_SIGNAL A m A B m EXAMPLE SIGNAL B
TATIS
SC70 5
UB
ENABLE B ® Be
EXAMPLE_SIGNAL C = i B @ EXAMPLE SIGNAL D
TATIS
SC70 5
>RA >RB
0K \_?*WOK
<, 0402, 0402

.

NS

Figure 2-2. Example of Individual FET Switches
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Figure 2-3 shows the equivalent circuit to Figure 2-2 but utilizes mechan-
ical switches that are in the same package. Notice the default is shown by
black boxes located closer to the 0N label of the switches. In order to dis-
connect these switches, physically move the switch to the 0FF position.

SWA
EXAMPLE_SIGNAL A m— 1 [ JE ' m EXAMPLE_SIGNAL B
[ |

EXAMPLE_SIGNAL_C m—2&.

DIP2
SWT020

F—a EXAMPLE_SIGNAL_D

Figure 2-3. Example of Mechanical Switch Equivalent to Figure 2-2

Figure 2-4 shows a bus switch example, reference designator UC (Pericom
PI3BLVD512ZHE), selecting between lettered functionality and numbered
functionality. The signals on the left side are multiplexed signals with
naming convention letter_number. The right side of the circuit shows the
signals separated into letter and number, with the number on the lower
group (eg. 0B1) and the letter on the upper group (eg. 082). The default
setting is controlled by the signal CONTROL_LETTER_NUMBER which is pulled
low. This selects the number signals on the right to be connected to the
multiplexed signals on the left by default. In this example, the Microchip
IO expander is not shown but controls the signal CONTROL_LETTER_NUMBER
and allows the user to change the selection through software.

Figure 2-5 shows the equivalent circuit to Figure 2-4 but utilizes mechan-
ical switches. Notice the default for reference designators SWC and SWD is
illustrated by black boxes located closer to the 0N label of the switches to
enable the number signals by default. Also notice the default setting for
reference designators SWE and SWF is OFF. In order to connect the letters
instead of the numbers, the user physically changes all switches on SWC and
SWD to the OFF position and all switches on SWE and SEF to the ON position.
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Figure 2-5. Example of Mechanical Switch Equivalent to Figure 2-4

SoftConfig on the ADSP-CM403F EZ-KIT LITE

The Microchip MCP23017 GPIO expander (U27) provides control for
individual electronic switches. The TWIO interface of the processor com-
municates with the Microchip device.

Table 2-1 lists the ADSP-CM403F processor and EZ-KIT Lite interfaces
that are available by default. Note that only interfaces affected by software
switches are listed in Table 2-1.
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Table 2-1. Default ADSP-CM403F Processor Interface Availability

Interface Availability by Default

UARTO RS-232 RX, TX and RTS enabled by default. SoftConfig required for other
functionality.

CANO Enabled in hardware, disabled in software to use LED1.

Push buttons Enabled

LEDs Enabled

Programming SoftConfig Switches

On the ADSP-CM403F EZ-KIT Lite, one Microchip MCP23017 device

exists. The device has the following programming characteristics:

* Each switch has two programmable GPIO registers.

GPIO Register Register Address
GPIOA 0x12
GPIOB 0x13

Each GPIO register controls eight signals (software switches).

* By default, the Microchip MCP23017 GPIO signals function as
input signals.

The signals must be programmed as output signals to override their
default values. The following table shows the Microchip register
addresses and the values that must be written to them to program
the signals as output signals.

IODIR Register [IODIR Register Address |Value to be Written to Program Signals
as Outputs

IODIRA 0x00 0

IODIRB 0x01 0
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Each of the software examples include a source file that programs the soft
switches, even if the default settings are being used. The README for each
example identifies only the signals that are being changed from their
default values. The code that programs the soft switches is located in the
SoftConfig_CM408F.c file in each example.

Table 2-2 outlines the default values for the Microchip MCP23017

device.

Table 2-2. I*C Hardware Address 0x40

GPIO MCP23017 Register Address Default Value
GPIOA 0x12 0xE0
GPIOB 0x13 0xC1

The ADSP-CM403F EZ-KIT Lite Schematic shows how the Microchip
GPIO expander (U27) is connected to the board’s ICs. All outputs drive
single signal FET switches. The CANO and LED1 circuits both use pro-
cessor port pin PB_15, and can be selected through SoftConfig. CANO
enable (CANO_ENO) controls whether the CAN port is enabled or the signals
are connected to the expansion interface. When CANO_EN is low, the CAN
interface is enabled and the processor signals (PC_00 and PB_15) are not
connected to the expansion interface. A CANO_EN setting of high connects
the signals to the expansion interface and disconnects the CAN port. This
is done through the inverter IC (U3).

Table 2-3 and Table 2-4 show the output signals of the Microchip GPIO
expander (U27), with a TWI address of 0100 001X, where X represents the
read or write bit. The signals that control an individual FET have an entry
under the FET column. The Component Connected column shows the
board IC that is connected if the FET is enabled. Also note that if a
particular functionality of the processor signal is being used, it will be in
bold font under the Processor Signal column.
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(U27 Port A)

Table 2-3. Output Signals of Microchip GPIO Expander

Bit |Signal Name Description FET | Processor Signal Component | Default
(if applicable) Connected

0 Not used Low

1 PB_10_J7_EN Processor pin PB_10 [ U8 |PB_10/SINCO_CLKO/ Low
connection to expan- SPI0_D2/CAN1_RX/
sion connector J7 SMCO_AWE/TMO_ACI1

2 | PB_11_J7_EN Processor pin PB_11 U9 | PB_11/SINCO_DO/ Low
connection to expan- SPIO_D3/CANI_TX/
sion connector J7 SMCO_AMSO/TMO_ACLK1

3 UARTORTS_EN UARTO RTS U10 | PB_04/PWM2_SYNC/ uz3 Low
connected to RS-232 UARTO_RTS/SPTO_
transceiver ATDV/SMCO_D12/CNT1_

ub

4 UARTORX_EN UARTO0 RX U1l [ PC_O1/UARTO_RX/ uz3 Low
connected to RS-232 SMCO_AO05/TMO_ACI5
transceiver

5 UARTOCTS_EN UARTO0 CTS Ul2 | PB_05/PWM2_TRIPO/ U36 High
disconnected from UARTO_CTS/TMO_TMR7/
RS-232 transceiver SMCO_D13/CNT1_DG
by default

6 UARTOCTS_RTS_LPBK | UARTO CTS and U13 U36 High
RTS not connected.
Change to low for
looping back RS-232
CTS and RTS signals

7 UARTOCTS_RST_EN UARTO CTS Signal ul4 U36 High
not connected to
input of reset IC

2-10 ADSP-CM403F EZ-KIT Lite Evaluation System Manual




ADSP-CM403F EZ-KIT Lite Hardware Reference

Table 2-4. Output Signals of Microchip GPIO Expander

(U27 Port B)

Bit|Signal Name Description FET |Processor Signal Component | Default
(if applicable) Connected
0 | CANO_EN Enables CAN 0, U15/ | PC_O0/CANO_TX/ uze Low
enabled by default Ule | SPTI_BTDV/UARTI_
TX/SMCO_A04 and PB_
15/CANO_RX/SPT1_
ATDV/UARTI_RX/
SMCO_AQ03/TMO_ACI4
1 PUSHBUTTONI_EN PF_10 is used as GPIO |U21 PF_10/ETHO_ U39 Low
input for push button PTPCLKIN
1, enabled by default
2 | PUSHBUTTONZ2_EN PE_08 is used as GPIO | U20 PE_08/ETHO_PTPPPS/| U39 Low
input for push button SMCO_A22/CNT2_7M
2, enabled by default
3 | LED1I_GPIO_EN PE_07 is used as GPIO | U19 PE_07/ETHO_ ub Low
output for LEDI, PTPAUXIN/SMCO_A21
enabled by default
4 | LED2_GPIO_EN PE_06 is used as GPIO | U18 PE_06/SMCO_A20 us Low
output for LED2,
enabled by default
5 | LED3_GPIO_EN PE_05 is used as GPIO |U17 PE_05/SMCO0_A19 ub Low
output for LED3,
enabled by default
6 | TRACE_EXP_EN Signals not connected Us1- | PB_00, PB_01, PB_ |[J2,Jd7 High
to expansion interface 55 02, PB_03, PC_02
7 | SPIFLASH_J2_EN Signals not connected U32- | PC_03, PC_05, PC_ |J2 High
to expansion interface | 36 04, PB_10, PB_11
by default
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Push Buttons and Switches

This section describes operation of the push buttons and switches. The
push button and switch locations are shown in Figure 2-6.

SW3  Sw4

Figure 2-6. Push Button and Boot Mode Switch Locations
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Boot Mode Select Switch (SW1)

The rotary switch (SW1) determines the boot mode of the processor.
Table 2-5 shows the available boot mode settings. By default, the
ADSP-CM403F processor boots from the on-board burst flash memory.

Table 2-5. Boot Mode Select Switch (SW1)

SW1 Position Processor Boot Mode

0 No Boot — Idle
1

SPI master boot (internal SPI2). Default boot mode.
2 SPI slave boot (SPI0)

3 UART boot (UARTO0)

Reset Push Button (SW2)

The reset push button (SW2) resets the processor (U1) and the GPIO

extender (U27). The reset also is connected to the expansion interface via
the SYS_HWRST signal.

GPIO Push Buttons (SW3-4)

The GPIO push buttons (SW3 and SW4) are connected to the processor’s
signals PB_06/PWM2_AH/TMO_CLK/SMCO_D14 and PB_07/PWM2_AL/TMO_TMRO/
SMC0_D15, respectively. The signals are connected by default.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual 2-13



Jumpers

Jumpers

This section describes functionality of the configuration jumpers.
Figure 2-7 shows the jumper locations.

JP4

01 Pe
O] PS

e C
V0T
oW

Figure 2-7. Jumper Locations
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VREFO External Source Jumper (JP1)

The VREFO external source jumper (JP1) selects whether an internal or
external voltage reference supplies the VREFO signal of the processor. When
a jumper on JP1 is not installed (default), the internal voltage reference
supplies VREF0. When a jumper on JP1 is installed, the external Analog
Devices ADR441 ultra-low noise voltage reference (U6) supplies VREFO.
Configure the processor’s registers accordingly for the latter case.

VREF1 External Source Jumper (JP2)

The VREF1 external source jumper (JP2) selects an internal or external volt-
age reference supply to the VREF1 signal of the processor. When a jumper
on JP2 is not installed (default), the internal voltage reference supplies
VREF1. When a jumper on JP? is installed, the external Analog Devices
ADR441 ultra-low noise voltage reference (U2) supplies VREF1. Configure
the processor’s registers accordingly for the latter case.

Buffer Input Select Jumper (JP3)

The buffer input select jumper (JP3) selects the input to the ADA4889
unity gain op amp buffer (U22). The processor’s internal input is selected
by placing a jumper on pins 1 and 2 of JP3 (default).

The external VREFO input, supplied by the Analog Devices ADR441
ultra-low noise voltage reference (U6), is selected by placing a jumper on
pins 2 and 3 of JP3.
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Power Select Jumper (JP4)

The power select jumper (JP4) selects the wall power (5V) when a jumper
is placed on positions 1 and 2. When a jumper is placed on positions 2
and 3, power from pins 177, 178, 179 and 180 of the PWM connector

(37) is supplied to the board. The default setting is positions 1 and 3,
which selects wall power.

Power Jumpers (P4-6)

Remove jumpers listed in Table 2-6 to measure the respective voltage
across the adjacent sense resistor.

Table 2-6. Power Jumpers

Power Jumper Resistor
P4 VDD_INT
P5 VDD_EXT
P6 3.3V
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LEDs

This section describes the on-board LEDs. Figure 2-8 shows the LED
locations.

LED4
ams]

- LED6
LEDS

LEDs

o oo oo

123

Figure 2-8. LED Locations
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GPIO LEDs (LED1-3)

Three LEDs are connected to the general-purpose I/O pins of the proces-
sor (see Table 2-7). The LEDs are active high and are ON (amber) by
writing a 1 to the correct processor signal.

Table 2-7. GPIO LEDs

LED Reference Designator Processor Programmable Flag Pin
LED1 PB_15
LED2 PB_04
LED3 PB_05

Reset LED (LED4)

When LED4 is ON (red), it indicates that the master reset of all the major
ICs is active. The reset LED is controlled by the Analog Devices ADM708
supervisory reset circuit. A master reset is asserted by pressing SW2 which
activates LED4. For more information, see Reset Push Button (SW2).

Power LED (LED5)

When LED5 is ON (green), it indicates that power is being supplied to the
board properly. For more information, see Power Architecture.

SYS_FAULT LED (LED6)

When LED6 is ON (red), it indicates a system fault. For more information,
refer to the ADSP-CM40x Mixed-Signal Control Processor Hardware
Reference.
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Connectors

This section describes connector functionality and provides information
about mating connectors. The connector locations are shown in

Figure 2-9.

DP7 = E

P |
1 P2

J3

J7

J1

J9

J8

Je

Figure 2-9. Connector Locations

@ Connectors on the back of the board are noted with dotted lines.
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DCE UART Connector (J1)

Part Description

Manufacturer

Part Number

DBY9 female

NORCOMP

191-009-213-L-571

Asynch or Memory Connector (J2)

Part Description

Manufacturer

Part Number

180-pin high speed socket

SAMTEC

QSH-090-F-D_A

Mating Connector

180-pin high speed header

SAMTEC

QTH-090-01-F-D-A

Character Display Connector (J3)

The character display connector (J3) is a socket that mates with the 20 x 2

character display.

Part Description

Manufacturer

Part Number

IDC 5x2 SMT

SAMTEC

SSW-105-22-F-D-VS

Mating Connector

20x2 character display with back-
light

NEW HAVEN DISPLAY

NHD-0220D3Z-FL-GBW
(requires header)
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PWM Connector (J7)

Part Description

Manufacturer

Part Number

180-pin high speed socket

SAMTEC

QSH-090-F-D_A

Mating Connector

180-pin high speed header SAMTEC QTH-090-01-F-D-A
CANO Connector (J8)

Part Description Manufacturer Part Number

RJ11 vertical DIGIKEY A31431-ND

Mating Connector

RJ11 cable
Analog Connector (J9)
Part Description Manufacturer Part Number
120-pin high speed socket SAMTEC QSH-060-F-D_A

Mating Connector

120-pin high speed header

SAMTEC

QTH-060-01-F-D-A

JTAG/SWD/SWV Connector (P1)
The JTAG/SWD/SWYV header (P1) provides debug connectivity for the

microprocessor. This is a 0.1” connector from SAMTEC
(SHF-110-01-L-D-TH). For more information, see Debug Interface.
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TRACE and JTAG/SWD/SWV Connector (P2)

The TRACE and JTAG/SWD/SWV Connector (P2) provides connectiv-
ity to the microprocessor’s trace interface. This is a 0.05” connector from

TE Connectivity (5103308-5).
Pin 7 is cut to provide keying.

Refer to the SoftConfig tables for information on enabling the Trace sig-
nals, specifically the TRACE_EXP_EN signal.

VREF Buffered Connector (P3)

The VREF buffered connector provides a means to measure the voltage of
the voltage reference. There is an adjacent analog grounding point (TP11).

Power Connector (P7)

Part Description Manufacturer Part Number

0.65 mm power jack CUI 045-0883R

Mating Connector

5.0VDC@3.6A power supply GLOBETEK GS-1750(R)
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A ADSP-CMA403F EZ-KIT LITE
BILL OF MATERIALS

The bill of materials corresponds to ADSP-CM403F EZ-KIT Lite

Schematic.
Ref. | Qty | Description Reference Manufacturer Part Number
Designator
1 1 ADM708SARZ SOIC8 | U28 ANALOG ADM708SARZ
DEVICES

2 1 ADP2119ACPZ-R7 VR1 ANALOG ADP2119ACPZ-R7
DFN50P300X300-11N DEVICES

3 2 ADR441ARMZ U2,U6 ANALOG ADR441ARMZ
MSOP8 DEVICES

4 1 ADP2118ACPZ VR2 ANALOG ADP2118ACPZ
QFN65P400X400X80- DEVICES
17N

5 1 ADA4899 SOICS8 U22 ANALOG ADA4899-1YRDZ-R7

DEVICES

6 1 ADM3252E U23 ANALOG ADM3252EABCZ
BGA44C100P11X11_ DEVICES
1200X1200X103

7 1 ADM3053 U26 ANALOG ADM3053BRWZ
SOIC127P1032X265-2 DEVICES
ON

8 1 ADSP-CM403FBSWZ | Ul ANALOG ADSP-CM403FBSWZENG
QFPS40P1600X1600X DEVICES
160-121N
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Ref. | Qty | Description Reference Manufacturer Part Number
Designator
9 47 0.1UF 10V 10% 0402 C1,C7,C8,C1 | AVX 0402ZD104KAT2A
1,C13,C16,C
19,C22,C25-
C30,C33,C42
-C44,C49,C5
1,C52,C55,C
56,C60,C63-
C66,C68,C72
-C74,C76,C7
7,C79,C95,C
99-C104,C11
1,C113-C115,
Cl174
10 37 0.01UF 16V 10% 0402 | C4-C6,C21,C | AVX 0402YC103KAT2A
23,C34-C40,
C48,C67,C69
,C71,C80-C8
9,C105-C110,
C112,C170-C
173
11 1 10UF 16V 10% 1210 C93 AVX 1210YD106KAT2A
12 2 1000PF 50V 5% 1206 C92,C94 AVX 12065A102]JAT2A
13 2 680 1/16W 1% 0402 R140,R141 BC COMPO- 2312 275 16801
NENTS
14 2 1.5UH 20% INDO003 L1,L2 COIL CRAFT DO1608C-152MLC
15 1 ROTARY SWT027 SW1 COPAL S-8110
16 1 MCP23017 u27 DIGI-KEY MCP23017-E/ML-ND
QFN65P600X600-29N
17 1 GREEN LED_0603 LED5S DIGI-KEY 475-1409-2-ND
18 | 3 0.1UF 16V 10% 0402 C57-C59 DIGI-KEY 587-1451-2-ND
19 1 30MHZ OSC012 U225 DIGI-KEY 300-8257-1-ND
20 2 RED LED_0603 LED4,LEDG6 DIGI-KEY 475-2512-2-ND
21 3 YELLOW LED_0603 LEDI1-LED3 DIGI-KEY 475-2558-1-ND
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ADSP-CM403F EZ-KIT Lite Bill Of Materials

Ref. | Qty | Description Reference Manufacturer Part Number
Designator
22 1 10UF 6.3V 20% 0402 C15 DIGI-KEY 445-8920-1-ND
23 1 STD2805T4 Q1 DIGI-KEY 497-7465-1-ND
TO228P972X240-3N
24 |7 IDC 2PIN_JUMPER_ | SJ1-S]J7 DIGI-KEY S9001-ND
SHORT
25 |1 PWR .65MM CONO045 | P7 DIGI-KEY CP1-023-ND
26 |1 1K 1/10W 5% 0603 R20 DIGI-KEY 311-1.0KGRTR-ND
27 1 4700PF 16V 10% 0603 | C70 DIGI-KEY 311-1083-2-ND
28 | 2 100 1/16W 5% 0402 R95,R96 DIGI-KEY 311-100JRTR-ND
29 | 6 330.0 1/16W 1% 0402 | R28,R77-R80, | DIGI-KEY 541-330LCT-ND
R91
30 | 6 IDC 2X1 IDC2X1 JP1,JP2,P3-P6 | FCI 90726-402HLF
31 2 IDC 3X1 IDC3X1 JP3,]P4 FCI 90726-403HLF
32 1 IDT74FCT3244APY Us IDT IDT74FCT3244APYG
SSOP20
33 1 TEST LOOP LOOP_ GP1 KEYSTONE 5016
2838
34 3 0 1/4W 5% 1206 R15,R21,R13 | KOA 0.0ECTRk7372BTTED
8
35 1 IDC 10X2 TE_ P1 MOUSER 571-5103308-5
5103308-5
36 |7 10UF 6.3V 20% 0603 C9,C10,C18, | MULTICOMP | MCCA000517
C24,C31,C32
,C41
37 1 190 100MHZ 5A FER3 MURATA DLW5BSN191SQ2
FER002
38 1 DB9 9PIN CONO038 J1 NORCOMP 191-009-213-L-571
39 1 GTL2002 TSSOP8 U24 NPX GTL2002DP118
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Ref. | Qty | Description Reference Manufacturer Part Number
Designator
40 | 3 5A MBRS540T3G D4,D6,D7 ON SEMI MBRS540T3G
SMC
41 3 MOMENTARY SW2-SW4 PANASONIC EVQ-Q2K03W
SWT024
42 | 13 | 0 1/16W 5% 0402 R6,R7,R19,R | PANASONIC | ERJ-2GEOR00X
32,R37,R103,
R108,R110,R
122,R131,R13
3,R135,R139
43 | 25 | 01/16W 5% 0402 R5,R18,R33, PANASONIC ERJ-2GEOR00X
R36,R68,R10
5,R106,R111,
R114-R119,R
121,R123,R12
7,R128,R132,
R134,R136,R
137,R147-R1
49
44 | 3 1UF 6.3V 20% 0402 C17,C90,C91 | PANASONIC ECJ-0EB0J105M
45 | 7 10UF 10V 10% 0805 C12,C14,C20 | PANASONIC ECJ-2FB1A106K
,C61,C62,C7
5,C78
46 | 2 27K 1/16W 5% 0402 R30,R31 PANASONIC ERJ-2GE]J273X
47 | 2 60.4 1/10W 1% 0603 R67,R70 PANASONIC ERJ-3EKF60R4V
48 1 45.3K 1/10W 1% 0402 | R113 PANASONIC ERJ-2RKF4532X
49 1 24.9 1/10W 1% 0402 R12 PANASONIC ERJ-2RKF24R9X
50 1 10UF 10V 20% ELEC_ | CT1 PANASONIC EEE-1AA100NR
4MM
51 | 26 | PI3A125 SC70_5 U8-U21,U32- | PERICOM PI3A125CEX
U38,U51-U55
52 4 0.0 1/10W 1% 0603 R13,R14,R16, | PHYCOMP 232270296001L
R17
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ADSP-CM403F EZ-KIT Lite Bill Of Materials

Ref. | Qty | Description Reference Manufacturer Part Number
Designator

53 1 200.0K 1/16W 1% R142 ROHM MCRO1MZPF2003
0402

54 1 IDC 5X2 IDC5x2_ J3 SAMTEC SSW-105-22-F-D-VS
SMT_F

55 1 0.05 10X2 SAMTEC_ P2 SAMTEC SHEF-110-01-L-D-TH
SHF-110-01-L-D-TH

56 | 2 0.5MM 180PIN SAM- | J2,]7 SAMTEC QSH-090-01-F-D-A
TEC_QSH-090-F-D-A

57 1 0.5MM 120PIN SAM- | J9 SAMTEC QSH-060-01-F-D-A
TEC_QSH-060-F-D-A

58 3 0.051 OHM 1/2W 1% | R38,R102,R1 | SEI CSF 1/2 0.05 1%R
1206 09

59 | 2 600 100MHZ 500MA | FERI,FER2 STEWARD HZ1206B601R-10
1206

60 |1 74LVCI14A SOIC14 U3 TI 74LVC14AD

61 1 SN74LVC1GO08 U31 TI SN74LVC1G08DBVE
SOT23-5

62 |2 SN74LVC1G08 U29,U30 TI SN74LVC1G08DBVE
SOT23-5

63 |1 RJ11 4PIN CONO039 J8 TYCO 5558872-1

64 1 3A RESETABLE F1 TYCO SMD300E-2
FUS004

65 |1 0 1/8W 5% 0805 R10 VISHAY CRCW08050000Z0EA
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Ref.

Qty

Description

Reference
Designator

Manufacturer

Part Number

66

54

10K 1/16W 5% 0402

R1,R8,R11,R

24-R27,R29,R
35,R41-R43,R
45,R46,R55-R
61,R64-R66,R
69,R73-R76,R
81-R90,R92,R
93,R97-R100,
R104,R112,R

124,R125,R14
3-R146,R224

VISHAY

CRCW040210K0FKED

67

10K 1/16W 5% 0402

R2-R4,R23,R
39,R40,R44,R
54,R126

VISHAY

CRCW040210K0FKED

68

4.7K 1/16W 5% 0402

R22

VISHAY

CRCW04024K70JNED

69

33 1/16W 5% 0402

R9,R62,R63,
R94,R101,R1
20

VISHAY

CRCWO040233R0JNEA

70

10 1/10W 5% 0603

R34,R71,R72,
R107

VISHAY

CRCWO060310R0JNEA

71

30A GSOT05 SOT23-3

D2

VISHAY

GSOT05-GS08

72

30A GSOT03 SOT23-3

D1,D3

VISHAY

GSOT03-GS08

73

22UF 16V 10% 1210

C45-C47,C96
-C98

YAIYO
YUDEN

EMK325B]226KM-T
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PB_08/PWM2_BH/TMO_TMRL/UART1_RX/SMCO_ARDY/TMO_ACI2

PB_09/PWM2_BL/TMO_TMR2/UART1_TX/SMCO_ARE
PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1
PB_11/SINCO_DO/SPI0_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1

PB_12/SINCO_D1/UART2_RX/SMCO_AOE/TMO_ACI3
PB_13/SINCO_D2/CNTO_OUTASPIO_SEL2/SMCO_A01/TMO_ACLKO/SYS_DSWAKE3
PB_14/SINCO_D3/CNTO_OUTB/SPI0_SEL3/SMCO_A02/SPI0_SS/SYS_DSWAKE2
PB_15/CANO_RX/SPT1_ATDV/UART1_RX/SMCO_A03/TMO_ACI4

s 103pB 08/PWM2_BH/TMO_TMRI/UARTL_RX/SMCO_ARDY!

s 104pp 09/PWM2_BL/TMO_TMR2/UARTL_TX/SMCO_ARE

B——4PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TN

= 50pPB_11/SINCO_DO/SPIO_D3/CAN1_TX/SMCO_AMSO/TMO

= 9IpB 12/SINCO_D1/UART2_RX/SMCO_AOE/TMO_ACI3

B——9PB_13/SINCO_D2/CNTO_OUTA/SPIO_SEL2/SMCO_A01/T

= BpB 14/SINCO_D3/CNTO_OUTB/SPIO_SEL3/SMCO_A02/S

m—PB_15/CANO_RX/SPT1_ATDV/UART1_RX/SMCO_AO03/T!

ADSP-CM403BSWZ
QFPS40P1600X1600X160-121N

UL
JTG_TCKISWCLK ® 3137G_TCKISWCLK
ITG_TMSISWDIO B——FI~ ~ ~_~0 34576 TMs/swDIO
JTG_TDI = 3951G_TDI
ITG_TDO/ISWO m——2~ ~ ~_~0 33476 TDOISWO
JTG_TRST = 323TG_TRST

TWIO_SCLE®—
TWIO_SDA=—
SYS_BMODEQ=5"-
SYS_BMODE1~>-
SYS_CLKINE"—
SYS_CLKOUTF=-
SYS_XTALE®—
SYS_HWRSTE—
SYS_NMIPZ—
SYS_FAULTS—
SYS_RESOUT—

ADSP-CM403BSWZ
QFPS40P1600X1600X160-121N




ADR441ARMZ

BUFFER_IN m——

VREF_BU

REFCAP B—

MSOPS
AGND
3.3V
AGND
u2
2 6 _ RI3 0.0
VIN VOUT, R m VREF1_ADR441
c103 1 8
— G1UE TPO TP1
0402
c102
4 0.1UF
ND  TRIM — 0i02
ADRA4TARMZ
MSOPS
AGND I
AGND
JP1 JP3
VREFO_ADR441 44 VREFO m—— % 1
VREFO 2+ + B BUFFER_IN
IDC2X1 VREFO_ADR441 B—— 3
IDC3XL
P2
VREF1_ADR441 m— 1
VREF1 m—— 4 |
IDC2X1
sJ3
SHORTING SHORTING
JUMPER JUMPER
DEFAULT=UNINSTALLED DEFAULT=1 & 2
sJ1
SHORTING
JUMPER
DEFAULT=UNINSTALLED
33V
O
BYP DO m— BYP Al B— VREF1
| cr7 | cuwo c16 | cs cr2 |
—10F T 10UF  O1UF ~ 10UF T 10UF
0402 0603 0402 0603 0805
AGND AGND AGND
Pins 55- Pins 80-79 Pins 72-71 Pins 73-74
Center pad

| c100 |

—_ 0.1UF -
0402

AGNI

Pins 75-




* AV

cat | ca
T 066 T 0402 NOTE: CONNECT PIN 98 DIRECTLY TO GROUND
FOR CUSTOMER DESIGNS
AGND
Pins 95-90
1.2V @ 1.5A
5v
O
R34
10 VR1
0603 L1
| 1 L5UF
. VIN INDO
ZovIN swe 3 288
0
) Tek ; 0402
SYNC/MODE] ®
| ca3 R33 R35
— T 01UF | c45 0 | caa 10K
0402 —  20UF 0402 —  0.1UF 0402
1210 0402 60008 -
27K
0402
o110 FB° .
GND PGND EPAD
ADPZI10ACPZ-R7 C— 11
DFN50P300X300-11N
Z ; R32 R37 R30
0 0 27K
0402 0402 0402
DNP DNP
L
o————4
VDD_EXT
VDD_INT
c24 c22 c25 c23 | ca c32 c28
10UF—  01UF _ 01UF__ 00l1UF _ _ 001UF 10UF  10UF _ 0.1UF__ 01UF __ 0.1UF 01UF  0.1UF
0402 0402 0603 0402




3.3V

c174
— 0.1UF
0402

NS

C173
0.01UF
0402

C172
0.01UF
0402

C171
0.01UF
0402

C170

0.01UF

0402

SPIFLASH_J2_EN
PC_03/SPI0_CLK/PWM2_CH

PC_05/SPI0_MOSI/PWM2_DH

PC_04/SPI0_MISO/PWM2_CL

PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1

PB_11/SINCO_DO/SPI0_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1

N
PB_10_J7_EN
PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1
PB_11_J7_EN
PB_11/SINCO_DO/SPI0_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1

<

<




PC_01/UARTO_RX/SMCO_AO5/TMO_ACI5 m 2, B

PI3A125
SC70 5
R57 R58
10K 10K
0402 0402
]
3.3V Z ;
o———4¢
R59 R60 R61
10K 10K 10K
0402 0402 0402
u12
UARTOCTS_EN = . 1o
PB_05PWM2_TRIPO/JUARTO_CTS/TMO_TMR7/SMCO_D13/CNT1 DG m 2 B
PI3AL125
SC70_5
u13
UARTOCTS_RTS LPBK ® 1o
2, =
'Y D
PI3AL125
SC70.5
u14
UARTOCTS_RST_EN ® 1o
CTs = 20 B
PI3AL125
SC70 5




1 ce7 C74 | C75 C73 p

0.01UF 0.1UF 10UF 0.1UF

“ [ 0402 0402 ~ [ o805 0402
L L

NS NS

Place between pins 6 and 7 Place between pins 8 and 9

20 X 2 Characte

J3
+ +

+ +
+ +
+ +
+ +

IDC5X2_SN

‘ =

[NJor W

TWIO_SDA_DISPLAY =

O | o b N

‘ ©

o NS

C78 C79

10UF — 0.1UF

0805 [ 0402




PB_08/PWM2_| BHFI'MO _TMR1/UART1_| RXISMCO ARDYITMO _ACI2

PB_11/SINCO_DO/SPIQ_| D3/CAN1 TX/SMCO-AMSO/MO_ACLK1 J2
_07/PWMO_CL/SMCO0_AMS2/SPT1_BD1

SYS_CLKOUT
PC_07/SINCO_CLK1/UART2_TX/UART1_RTS/SYS_DSWAKE1

TWIO_SDA
PC_03/SPI0_CLK/PWM2_CH_J2

PC_05/SPI0_MOSI/PWM2_DH_J2
PB_11/SINCO_DO/SPI0-D3/CAN1_TX/SMCO-AMSO/TMO_ACLK1 J2
PB_14/SINCO_D3/CNT0_OUTB/SPIO_SEL3/SMCTO0_A02/SPT0_SS/SYS_DSWAKE2
PB_137SINCO_D2Z/CNTO_OUTASPIO_SEL2/SMCO_AO01/TMO_ACLKO/SYS_DSWAKE3

B -06/PWM2-AH/TMO0_CLK/SMCO_D14
PB_08/PWM2_BH/TMO TMRﬂUARTl RX/SMCO_ARDY/TMO_ACI2

SYS_FAULT

PB_09/PWM2_BL/TMO_T

» u
73 |74
: o CONTROL T
77 |78
__ 79| |80
__ 81| g2
83| 84 m SYS_NMI
- 85 86 ® SYS_HWRST
87 1 88 -
= 89 190 T g PB 12/SINCO_D1/UART?
__91] UART |92
= 93 TWI— 94 m TWIO_SCL
- 95 96 m PC O4/SPIO MISO/PWM
= 97 98 m PBT10/SINCD_CLKO/SPI(
- 99 100 m PC_02/UARTO_TX/TRAC
- 101 102 m PC_06/SPI0_SEL1/PWM:
- 103 104 m PB_14/SINCO_D3/CNTO_
105 106
107 SPI 108
— 109 110 —=a PB_07/PWM2_AL/TMO_T
= 111 GF;IO 112 m PBZ09/PWM2_BL/TMO_T
113 114
115 116
_ 117 | 118
__ 119 | 120
189 185
190 186
e 1911 l187 ¢
192 188
RESERVED
121 | 122
123 | 124
125 | 126
127 | 128
129 | 130
131 | 132
133 | 134
135 - | 136
137 | 138
139 | 140
141 ) | 142
143 = | 144
145 | 146
147 L [ 148
149 150 1Y
151 [ 152 O
153 - | 154
155 | 156
157 5 [ 158
- 159 SYys |- 160 m SYS_RESOUT
161 162 -
163 164
165 L 166
167 168
169 POWER 170
171 172
P 173 174 ®
175 176
177 178
179 180
SAMTEC_QSH-090-F-D-A
PB_08/PWM2_BH/TMO_TMR1/UART1_RX/SMCO_ARDY/TMO0_ACI2
R146
10K
0402




[— 0402
o O 9 T8
Sw3
MOMENTARY g§¥€i4A
SWT024
C90
~AUF
0402
R98
10K
0402
LABEL "PB2" R96
100 U3
— 0402
) O O 7 SHG
Swa
MOMENTARY gg%§j4A
SWT024
| cu
1UF
0402
3.3V

0402

R101
0402

3.3V

cs7 |
~ 0.0LUF _
0402

FUITIDU T TUINL LN

4 A2 PB_06/PWM2_AH/TI
PI3A125
SC70_5
R97
10K
0402
U20
OEL m PUSHBUTTONZ_EN
4 A2 m PB_07/PWM2_AL/T)
PI3A125
SC70_5
R92
10K
0402
| css
— 0.01UF
0402

74LVC14A
SOIC14

74LVC14A
SOIC14

74LVC14A
SOIC14

| c89
— 0.01UF
0402




__ 1000PF 1206
1206 A~

FER1
600
1206

SHGND
3.3V @
5v
O
R107
10 VR2
0603
14N
13
. . PVINO
T 1200
3TRK
| coe | cos R106 | C95
T 01UF T 22UF 0 ~ T 01UF
0402 1210 0402 0402
O -
¢ N o 25
Z &¢
(O] (ol
ADPZ118ACPZ 5 67
<~ 7 QFN65P400X400X80-17N
R103
0
0402
DNP




|  INDEX

A

ADSP-CM403F processor, x

analog connector (J9), 2-21
architecture, of this EZ-KIT Lite, 2-2
asynch or memory connector (J2), 2-20

B

bill of materials, A-1
board schematic (ADSP-CM403F), B-1
bus switch, 2-5

example, 2-6

C

CANO connector (J8), 2-21
character display connector (J3), 2-20
configuration, of this EZ-KIT Lite, 1-3
connectors, 2-19

diagram of locations, 2-19

J1 (DCE UART), 2-20

J2 (asynch or memory), 2-20

J3 (character display), 2-20

J7 (PWM), 2-21

18 (CANO), 2-21

J9 (analog), 2-21

P1 JTAG/SWD/SWV), 2-21

P2 (TRACE and JTAG/SWD/SWV),

2-22
P3 (VREF buffered), 2-22
P7 (power), 2-22

contents, of this EZ-KIT Lite package, 1-2

D

DCE UART connector (J1), 2-20

debug interface, 1-10

default configuration, of this EZ-KIT Lite,
1-3

default jumper and switch settings, 1-4

default processor interface availability, 2-7

design reference information, 1-13

E

EngineerZone, xviii
example programs, 1-13
expansion interface, 1-11

F

FET switches, 2-4
example, 2-4

G
general-purpose I/O pins (GPIO), 2-18

I
installation, of this EZ-KIT Lite, 1-4, 1-5

J
JTAG/SWD/SWV connector (P1), 2-21
jumpers

diagram of locations, 2-14
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L

LEDs, 2-17
diagram of locations, 2-17
LED1-3 (GPIO), 2-18
LED4 (reset), 2-18
LEDS5 (power), 2-18
LEDG (SYS_FAULT), 2-18

M

mechanical switch, 2-5, 2-7

N

notation conventions, xviii

p

package contents, 1-2
power
architecture, 1-12
LED (LED5), 2-18
measurements, 1-12
power connector (P7), 2-22
power-on-self test (POST), 1-11

product overview, x

programming SoftConfig switches, 2-8

push buttons and switches, 2-12
PWM connector (J7), 2-21

R
reset LED (LED4), 2-18

S

schematic, of ADSP-CM403F EZ-KIT
Lite, B-1
serial liquid crystal display module
interface, 1-10
SoftConfig
on the EZ-KIT Lite, 2-7
overview, 2-3
programming switches, 2-8
supported tools, xvii
switches
programming SoftConfig, 2-8
switches, diagram of locations, 2-12
SYS_FAULT LED (LEDG6), 2-18
system architecture, of this EZ-KIT Lite,
2-2

T

technical support, xvi
TRACE and JTAG/SWD/SWYV connector
(P2), 2-22

Vv
VREF buffered connector (P3), 2-22
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X-ON Electronics

Largest Supplier of Electrical and Electronic Components

Click to view similar products for Development Boards & Kits- ARM category:
Click to view products by Analog Devices manufacturer:

Other Similar products are found below :

SAFETI-HSK-RM48 PICOHOBBITFL CC-ACC-MMK-2443 TWR-MC-FRDMKEO2Z EVALSPEAR320CPU EVB-SCMIMX6SX
MAX32600-KIT# TMDX570LS04HDK TXSD-SV70 OM13080UL EVAL-ADUC7120QSPZ OM13082UL TXSD-SV71

Y GRPEACHNORMAL OM13076UL PICODWARFFL YR8A77450HA02BG 3580 32F3348DISCOVERY ATTINY 1607 CURIOSITY
NANO PIC16F15376 CURIOSITY NANO BOARD PIC18F47Q10 CURIOSITY NANO VISIONSTK-6ULL V.2.0 80-001428 DEV-17/717
EAKO00360 YROK77210BOOOBE RTK7EKA2L1S00001BE MAX32651-EVKIT# SLN-VIZN-IOT LV18F V6 DEVELOPMENT SYSTEM
READY FOR AVR BOARD READY FOR PIC BOARD READY FOR PIC (DIP28) EVB-VF522R3 AVRPLC16 V6 PLC SYSTEM
MIKROLAB FOR AVR XL MIKROLAB FOR PICL MINI-AT BOARD -5V MINI-M4 FOR STELLARIS MOD-09.Z BUGGY +
CLICKER 2 FOR PIC32MX + BLUETOOT 1410 LETS MAKE PROJECT PROGRAM. RELAY PIC LETSMAKE - VOICE
CONTROLLED LIGHTS LPC-H2294 DSPIC-READY?2 BOARD DSPIC-READY 3 BOARD MIKROBOARD FOR ARM 64-PIN
MIKROLAB FOR AVR
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